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RELEASE NOTES

LOOKOUT  4.0 RELEASE NOTES
Welcome to Lookout 4.0. This edition of the Lookout HMI/SCADA 

package introduces easy TCP/IP-based networking for all your automation 

and control needs. Along with the new capabilities for easy networking, 

Lookout 4.0 also introduces new productivity tools such as the Lookout 

Object Explorer and the Lookout Connection Browser, to help you in 

developing and maintaining your Lookout processes. Updated Lookout 

objects such as the Pot, RadioButton, Pushbutton, Switch, TextEntry 

controls, and the HyperTrend all contribute to the power and efficiency of 

Lookout processes using your own network. With the capacity to export an 

ActiveX version of a client process, Lookout can help you monitor your 

processes using Internet Explorer.

The Lookout 4.0 Release Notes contain the following:

• Requirements for running Lookout 4.0

• A roadmap to where you can find answers to your questions about 

Lookout 4.0

• New features and corrections that did not make it into the print 

documentation

• Information on how experienced users of Lookout 3.8 can take 

advantage of new features and development techniques available in 

Lookout 4.0

• How to convert Lookout 3.8 processes to run under Lookout 4.0

• Information on compatibility issues between Lookout 4.0 and earlier 

versions of Lookout

For the most recent Lookout news and updates, point your browser to 

this site:

http://www.natinst.com/lookout/

™
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Requirements

Lookout requires the following:

• Pentium class PC running at 90 MHz or faster

• At least 32 MB RAM

• 45 MB free disk space, plus possibly 100 MB or more, depending on 

how much data you intend to log to the Lookout database, Citadel. You 

should also have about 50 MB of disk space for file swapping on 

Windows NT computers.
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• Windows 98/95 or Windows NT version 4 or later

• Network card and TCP/IP networking installed on the computers you 

want to connect, if you intend to take advantage of Lookout 

networking

While minimum requirements for running Lookout will run Lookout 

processes, you may find that large processes which draw heavily on 

computer system resources will benefit from faster computers that have 

more RAM and disk memory than the minimum requirements. For 

example, if your Lookout processes 25,000 traces or more, you should use 

a Pentium 450 MHz computer with at least 256 MB of RAM.

Because Lookout can run 24 hours a day, your computer should have some 

form of AC power surge protection. An uninterruptible power supply 

(UPS) provides the ultimate protection. A UPS provides complete isolation 

between the AC power source and the computer and has backup battery 

power if there are blackouts and brownouts. A quality surge protector will 

protect your computer from most electrical surges and spikes if you do not 

need battery backup.

Caution If you are running Windows 95 with no service pack upgrades, you may 

experience difficulties in networking with Lookout 4.0. If your computer begins to behave 

erratically after networking with Lookout 4, you may need to install an updated 

kernel32.dll from Microsoft. You can download this upgrade from Microsoft using the 

following URL:

http://www.our-town.com/win95maint/win95maint.htm

More details on the underlying problem can be found at the following URL:

http://www.microsoft.com/Windows95/downloads/contents/WUAdminTool/

S_WUNetworkingTools/W95Kernel32/Default.asp

Lookout is Y2K compliant and requires no special considerations for the 

year 2000.

Installation
Installing Lookout 4.0 is more than just copying files to your computer. 

You must register Lookout for long term use of your I/O points, and for 

instances of Lookout that are intended to run server processes, you must 

also register to activate your client connections. There are also a number of 

Lookout system configuration options you should set when you install. If 

you plan on networking with Lookout, you should also test to make sure 

TCP/IP is present and running on all the computers you intend to use 

Lookout with over a network.
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Avoid installing Lookout 4.0 over Lookout 3.8 or earlier. Either uninstall 

Lookout 3.8, or put Lookout 4.0 in a new directory. You can transfer or 

copy Lookout 3.8 process files for converting. If you were using a 

pre-release version of Lookout 4, either a beta or the Lookout 4 Preview, 

you should uninstall before installing the release version of Lookout 4.0.

If you are replacing your current copy of Lookout with Lookout 4.0, and 

your previous version was purchased from National Instruments, your 

earlier registration keycode will work to maintain your I/O licensing. You 

must register your client connection levels separately, however. Get your 

client connection keycode (and an upgraded I/O point keycode as well, if 

necessary) by registering Lookout with National Instruments, using the 

Lookout Registration Form included in your Lookout package.

Lookout 3.8 can run on the same computer with Lookout 4.0, and a process 

in one can be networked to a process in the other using NetDDE. Start the 

earlier version of Lookout first, though, if you intend to run both versions 

on one computer.

See Chapter 1, Installing Lookout, in the Getting Started with Lookout 

manual for detailed information on installation, testing TCP/IP networking, 

registering Lookout to authorize your I/O points and client connections, 

and configuring the Lookout system options.

Corrections and Additions to the Documentation

This section contains information and corrections which did not make it 

into the Lookout manual set.

Overwriting PLC Registers
The nature of PLC communications creates the possibility of a race 

condition—a race in which the last change to a register wins. Allowing 

writes to a Lookout PLC register by any means other than through Lookout 

creates the possibility that crucial values might be overwritten. Reserving 

registers for use by Lookout only should eliminate this potential problem.

Caution National Instruments strongly recommends that you set aside registers in your 

PLCs for Lookout communications and that you do not allow any changes to be made to 

those registers except through Lookout.

Uninstallation Problems with Lookout
If you were using a pre-release version of Lookout 4, either a beta or the 

Lookout 4 Preview, you should uninstall before installing the release 

version of Lookout 4.0.
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In some cases you may find your computer hanging during uninstallation, 

whether you uninstall from the Windows control panel or from the Lookout 

4.0 installer. Rebooting your computer and then uninstalling again should 

resolve this problem.

Registering Computers in Client Versions of Lookout
To monitor alarms generated on other computers running Lookout on your 

network, a client version of Lookout must register computers running 

Lookout just as a server version of Lookout does.

Because client versions have no editing or development capability, you 

cannot register a computer using the Lookout Object Explorer or the 

Lookout Connection Browser. You must use the Select Processes for 

Alarms dialog box instead.

In order to register a computer using this dialog box, select Alarms»Select 

Processes from the Lookout menu. The Select Processes for Alarms 

dialog box appears.

 

Right-click on the Network node and select Register Computer. Complete 

the registration as described in the Registering Computers section of 

Chapter 4, Networking, of the Lookout Developer’s Manual.

You can also register computers through the Select Processes for Alarms 

dialog box in Lookout server versions.
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Client and Server Versions of Lookout and Driver Objects
Lookout comes in several variations of two basic versions, the server 

version and the client version.

The server versions of Lookout are used to develop Lookout processes and 

run those processes on computers with physical connections to field 

hardware. Server versions of Lookout come in various packages with 

different I/O and client connection licenses, either with development 

capabilities or as a run-time only server.

The client run-time version of Lookout is a run-time only version that is 

distributed free. You can purchase a client development version of Lookout 

that you can use to create and edit client processes.

Lookout client processes should be created to run on any computer, with no 

physical connections to field hardware. For this reason, any process that 

contains a Lookout driver object (any of the Lookout objects used to control 

PLCs and other industrial automation hardware) does not run in the client 

versions of Lookout. The client development version of Lookout does not 

include or allow the use of driver objects in creating or editing client 

processes.

Any process you create containing Lookout driver objects must be run in a 

Server version of Lookout. 

Programmable Control of Panels
Lookout now allows you to control the size and location of your control 

panels programmatically.

The default size for a control panel is still set with the parameters for height 

and width in the New Control Panel dialog box. The default location for a 

control panel is where the panel was located when it was last moved or 

resized in edit mode.

Once you connect the size and location data members, however, these 

defaults are overridden by the values input through the connections.

Size and location values are interpreted as pixels. If your Lookout window, 

or your PC screen resolution, is smaller than the number of pixels input, 

your control panel may become too large to fit in the Lookout window, or 

may travel out of the window and be lost from view. Take the screen 

resolution and the size of your Lookout window into consideration when 

setting limits on the location data member inputs.
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DDE Data Exchange Between Lookout and Excel
In some cases you may experience difficulty in exchanging data with 

Microsoft Excel when using a data table to exchange values with a 

collection of cells.

The main symptom of this problem occurs when you change a single value 

in an Excel cell. In this case when Lookout updates the values in the data 

table, the changed value is correct, but the rest of the table values have been 

set to 0 instead of retaining their correct values.

To correct this problem, close Lookout. Use any text editor to open your 

lookout.ini file, located in your Lookout directory. Search for the 

[DDE] section. If there is no [DDE] section, you can create one. Enter 

FirstFormat=1 and save the .ini file.

For more information on the lookout.ini file, see Appendix C, The 

Lookout .INI File, of the Lookout Developer’s Manual.

Data Member Name Type Read Write Description

Height numeric yes yes Height of the dialog box in pixels. 

Once connected, this data member 

overrides the Height parameter 

entered in the New Control Panel 

dialog box.

Width numeric yes yes Width of the dialog box in pixels. 

Once connected, this data member 

overrides the Width parameter 

entered in the New Control Panel 

dialog box.

X numeric yes yes Horizontal coordinate of the upper 

left corner of the control panel. The 

upper left corner of the Lookout 

window is the 0 point. 

Y numeric yes yes Vertical coordinate of the upper left 

corner of the control panel. The upper 

left corner of the Lookout window is 

the 0 point. 
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SQL Queries with Microsoft Excel
If you are using Microsoft Excel 97 version SR-2, you may experience 

difficulties attempting to access the Citadel database. If you need to access 

the Citadel database with Microsoft Excel, National Instruments 

recommends use of a version other than the SR-2 version of Excel 97. 

HyperTrend Size Considerations
If you make a HyperTrend object too small, you may crowd the cursor 

marker (shown in the following illustration) out of the HyperTrend control 

bar. If your HyperTrend is not wide enough to display the HyperCursor 

marker, the HyperCursor will not function. To fix this problem, resize your 

HyperTrend object.

Data Quality and Lookout Driver Objects
While Lookout reports on data quality for all Lookout system objects, not 

all Lookout driver objects report data quality. 

The following Lookout driver objects do report data quality:

• Allen-Bradley

• National Instruments FieldPoint

• GE Series 90

• DL205

• DL405

• Modbus

• Modbus MOSCAD

• National Instruments OPCClient

• Optomux

• S5 3964

• Siemens TI505

• Simatic S5

• Tesco

• Tiway
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Using OPC with Lookout 
This section details several issues you need to be aware of when using OPC 

with Lookout.

OPCClient Performance 
National Instruments recommends that you use the OPCClient object to 

communicate with National Instruments Data Acquisition, SCXI, and 

FieldPoint products when possible for performance reasons.

Also, you will increase performance when you use Lookout with the 

OPCClient on the same computer as the OPC server application you are 

exchanging data with. You can then use the TCP/IP-based networking built 

into Lookout to pass this data across the network to other Lookout clients 

and servers.

Editing the OPCClient Database
When you open the OPCClient database to work with the OPC data 

members, you must manually set the data type for each data member when 

you select it. Lookout does not automatically set a data type for an 

OPCClient data member.

Security and OPC Client/Server 
When you disable task switching as a security option by selecting User 

cannot switch to another program in the System Options dialog box, 

you disable all top level windows. This can cause problems with OPC 

servers under Windows 95 when someone with a security level lower than 

the level you set logs in to Lookout.

To fix this problem, add the following lines to your lookout.ini file 

using any text editor:

[Security]

DisableWindows=0

This .ini file setting fixes the OPC problem, but it does mean that an 

operator can switch to other applications if he can click on their windows 

or on their icons in the task bar. To maintain security, make sure you select 

the Lookout will always be maximized option in the System Options 

dialog box, and make sure that your Windows taskbar (accessed by 

selecting Start»Settings»Taskbar) is set to Auto hide, and that Always 

on top is disabled.

For more information on the lookout.ini file, see Appendix C, The 

Lookout .INI File, of the Lookout Developer’s Manual.
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Networking Your Computers
Under some circumstances you may need to network two computers 

yourself, or remove a computer or two from your network as a part of your 

development process. A short PDF document containing brief, basic 

instructions for simple networking setups can be found in your Lookout 

documentation folder in a file called NWSetup.pdf.

ODBC Information
While Lookout does install a Lookout ODBC driver, you must manually 

create your own data source in order to access the Citadel database using 

ODBC. Consult Chapter 8, Structured Query Language, of the Lookout 

Developer’s Manual for information on how to create your Lookout data 

source.

Note Some applications are not completely ODBC compliant. If you plan to use 

Microsoft Query, Microsoft Access, or Microsoft Visual Basic, ensure that the maximum 

column name length does not exceed 62 characters. These applications cannot handle 

longer names. Applications that are completely ODBC-compliant can handle names up to 

126 characters long. All traces whose names exceed the maximum column name length are 

excluded from queries.

Because Lookout objects may include network path information in their names, and 

because you can arrange Lookout objects in hierarchies inside your processes, you may 

find it easy to exceed the 62 and 126 character limitations of ODBC. Consideration given 

to naming and organizing objects can minimize the risk of encountering this difficulty.

PDF Documentation
The Lookout Object Reference Manual is available in Portable Document 

Format (PDF) on the Lookout CD in the Documentation directory. The 

Lookout installation gives you the option of copying the PDF files into the 

Lookout/Documentation folder on your hard drive. To view these files, 

you must have Adobe Acrobat Reader 3.0 or later installed. If you do not 

have Adobe Acrobat Reader installed, you can install it from the 

Lookout/Documentation directory by running rs40eng.exe or from 

the Adobe web site at www.adobe.com. 

For Experienced Users of Lookout

In order to add easy and convenient networking to Lookout 4.0, a number 

of changes have been necessary in the way some things are done in 

Lookout. 

Many of these changes are simple and easy to adapt to, such as the ability 

of Lookout 4.0 to run more than one process at a time, or the ability to 



© National Instruments Corporation 11 Lookout 4.0 Release Notes

arrange your Lookout objects into folder hierarchies for easier maintenance 

and development. 

A few changes connected to the flexibility necessary for networking may 

take a few minutes study to master.

This section briefly explores changes in Lookout 4.0, and directs you when 

necessary to more detailed information contained in the Lookout manuals 

and online help. You should also read the Compatibility and Conversion 

with Lookout 4.0 section of these release notes for information involving 

specific compatibility and conversion issues.

Chapter 5, Developer Tour, of the Getting Started with Lookout manual 

demonstrates the new Lookout tools and capabilities in a series of simple 

exercises. Completing the exercises in this chapter is another way to 

quickly familiarize yourself with the new features of Lookout 4.0.

General Changes
As previously mentioned, Lookout now can run more than one process at a 

time. While there is no limit to the number of processes you can load, the 

more Lookout has to handle, the greater the demand it will make on your 

computer system resources. 

You can now arrange Lookout objects in folder hierarchies to make 

maintenance and development easier. The new Object Explorer and 

Connection Browser tools make this sort of organization easy to 

accomplish. See the Object Explorer and Connection Browser sections of 

Chapter 2, How Lookout Works in the Getting Started with Lookout manual 

for more information on these two new Lookout tools.

Lookout data is now polymorphic, which means that you can, to some 

extent, connect output data of one type—numeric, logical, or text—to 

inputs requiring data of a different type. When possible, Lookout interprets 

the data received as the type of data the input requires. See the Data 

Polymorphism section of Chapter 2, How Lookout Works, in the Getting 

Started with Lookout manual. 

Because you can now easily acquire and process data from across a 

network, Lookout has added a data quality mechanism. When data arrives 

in a Lookout client that has been corrupted, or when a data source falls off 

line, Lookout notifies you by placing a large red X over any display element 

for that data. Consult your alarm window for error messages.

Development versions of Lookout now install with no password set for the 

Administrator user account. When the Administrator account has no 

password, Lookout opens with the Administrator account active and 

without asking you to log in. This is a convenience for developers, but you 
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must make sure to set a password for the Administrator user account before 

giving anyone who should not have administrator privileges access to any 

version of Lookout using a Lookout.sec file with no Administrator 

password. 

Note Server and client run-time versions of Lookout open with the (nobody) user account 

logged in, no matter what the password setting is for the Administrator account. 

Data Location
Lookout stores historical, alarm, and event data in the Citadel database that 

operates as a background service on your Lookout computer. You can set 

the default Lookout location you want Citadel to store data in when you 

install Lookout and configure the basic system options. This default can be 

anywhere on your computer, or on any networked computer with 

Lookout 4 installed.

You can set a different location for database files for each process if you 

choose, overriding the Lookout default for that process. 

You can override both the system option default for Lookout and the 

process default with the Loader object. 

Lookout state files can also be saved under different names and different 

locations, according to settings you make when creating or modifying a 

process or when using a Loader object. 

For more detailed information on data locations and how different elements 

of Lookout affect data location, see the Setting System Options section of 

Chapter 1, Installing Lookout, in the Getting Started with Lookout manual; 

the Creating a Lookout Process section of Chapter 4, Using Lookout, also 

in the Getting Started with Lookout manual; and the Loader object 

documentation in your online help or in the PDF Lookout Object Reference 

manual.

Alarms
Alarms and events are both displayed in the Lookout alarm window, and 

Lookout has added alarm filtering and printing options to make handling 

alarms easier. 

You now select which processes you want Lookout to monitor alarms in, 

and your selection can include processes running on another instance of 

Lookout located on your Lookout network. 

Lookout alarms are also arranged in a folder hierarchy. Every time you 

define an alarm area, Lookout creates a folder for that area. You can use 
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data members incorporated in that folder to track and acknowledge alarms 

in that area programmatically.

See Chapter 9, Alarms, of the Lookout Developer’s Manual for more 

detailed information on Lookout alarms.

Events
Events are now stored in the Citadel database, along with alarms and 

logged data. To display events, select the Events Only or Alarms & 

Events display options in the Alarm Filters dialog box, accessed by 

selecting Alarms»Filter Options.

Networking
When you install Lookout 4.0 on computers connected by a network using 

TCP/IP protocols, you are ready to network your Lookout processes. All 

you have to do is use the Lookout Object Explorer to register the computers 

you want Lookout to communicate with on the network and begin 

developing your processes. 

To test your network and make sure your computers can communicate, ping 

each computer on your network as described in the Testing TCP/IP section 

of Chapter 1, Installing Lookout, in the Getting Started with Lookout 

manual.

To work through examples using Lookout networking, see Chapter 5, 

Developer Tour, of the Getting Started with Lookout manual. 

To make sure your data logging works correctly, make sure you time 

synchronize your Lookout processes as described in the Time 

Synchronization section of Chapter 4, Networking, in the Lookout 

Developer’s Manual.

For a compete look at networking in Lookout 4.0, consult Chapter 4, 

Networking, in the Lookout Developer’s Manual.

Connections
You can now make quick and easy connections that work over a network. 

For network connections to work properly, however, software must have 

proper path information to know where to find data and where to put data. 

In the case of client processes that may move from computer to computer, 

and which may be loaded and unloaded, networking also requires that 

controls take their initial values from the servers those controls interact 

with.
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The Connecting Objects section of Chapter 4, Using Lookout, in the 

Getting Started with Lookout manual covers the new way of making 

connection in Lookout, and in particular the new URL connections used by 

controls for a remote position source connection. 

Lookout automatically selects a path for data when you make a connection, 

but you can also easily override that selection yourself. For a detailed 

explanation of paths and how to use them, see the Path Names in Lookout 

section of Chapter 4, Using Lookout, in the Getting Started with Lookout 

manual.

All the Lookout connections, including the new URL connections for 

objects and the Lookout Symbolic Link are demonstrated in the exercises 

of Chapter 5, Developer Tour, of the Getting Started with Lookout manual.

New and Improved Objects
Lookout 4.0 features several new and several improved objects for you to 

use in your processes. 

One of the improvements is a help button located on the dialog boxes you 

use to create or modify a Lookout object. Clicking on the help button opens 

the Lookout online help topic for that object.

The Pot, Switch, Pushbutton, and TextEntry objects have all changed to 

accommodate networked client/server operations. The old versions of these 

controls, now called L3Pot, L3Switch, L3Pushbutton, and L3TextEntry, are 

still active in Lookout 4.0 for compatibility reasons, but you cannot create 

new instances of these objects.

Lookout now also has RadioButtons and a Sequencer object, along with a 

Waveform object. These objects have been available in recent Lookout 

maintenance releases, and so may be new to some Lookout users who have 

not installed a maintenance release.

Completely new in Lookout 4.0 and created especially for useful 

networking operations are the Loader, Monitor, and Symbolic Link objects. 

While these three objects are necessary for equipping your Lookout 

computer network with redundancy, you can also use them in other 

convenient ways. The symbolic link, for instance, not only stands in for an 

entire remote process, it is also handy as an intermediary when you need to 

make a URL connection involving a complex expression (you cannot enter 

a complex expressions in a URL field). With the Loader object, you can 

load one process file a number of times, giving each load a different process 

name and logging the data from that process to a unique destination, saving 

a unique state file as well. 
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In addition to the classic library of driver and protocol objects, Lookout 

now has an improved OPCClient object, support for the FieldPoint 

FP-1600 module, and a new DNP driver.

The Lookout Object Reference manual is now available in two forms: as an 

online WinHelp system you access through Lookout help and as a .pdf 

document which you can browse, copy from, or print using Adobe Acrobat. 

For complete details on new as well as improved Lookout objects, consult 

either of these references.

Lookout on the Web
In addition to running Lookout client processes in Lookout, you can also 

export an ActiveX version of a Lookout client process that will appear on 

an HTML page. You can then access this web client through Microsoft’s 

Internet Explorer.

For details on exporting a Lookout web client to an HTML page, or 

downloading a Lookout client in your own browser, see Chapter 11, 

Lookout Web Clients, in the Lookout Developer’s Manual.

Security
Lookout 4.0 adds permissions security to the control security used 

by Lookout 3.8. You can now configure processes and elements of 

processes for network security quickly and easily.

Note For your user accounts to work consistently across your network, you must use 

the same lookout.sec file for all your installed copies of Lookout. After you have 

created your lookout.sec file, make a copy of it from your WINDOWS\SYSTEM directory. 

Place a copy of the file in the WINDOWS\SYSTEM directory of each of your Lookout 

computers.

See Chapter 6, Security, of the Lookout Developer’s Manual for 

information on Lookout 4.0 security and how it integrates with Lookout 3.8 

security. 

Compatibility and Conversion with Lookout 4.0

You should be able to open all your Lookout 3.8 processes in Lookout 4.0 

with little or no difficulty. Some minor adjustments may have to be made 

in some processes, and you will have to change redundancy using backup 

computers. This section covers compatibility and conversion issues for 

Lookout 4.0.
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Lookout 3.8 and Lookout 4.0 Compatibility 
The following list contains known compatibility issues and fixes for 

Lookout 4.0:

• Lookout 4.0 does not run on Windows NT version 3.51 or earlier—you 

must be using Windows NT 4.0 or later.

• Earlier versions of Lookout process files used the file extension .lkp, 

and state files used the extension .lst. Lookout 4.0 uses the .l4p 

extension for process files and .l4t for state files.

If you want to run your old 3.8 processes on a 3.8 version, save the 

files. Otherwise, recompiling a 3.8 process will create (if you save) 

new .lks, .l4p, and .l4t files. Lookout also creates new security 

files using the extension .lka.

• Avoid installing Lookout 4.0 over Lookout 3.x.xx. Either uninstall your 

previous version of Lookout, or put Lookout 4.0 in a new directory, 

transferring or copying files for conversion. 

• Lookout 3.x.xx can run on the same computer with Lookout 4.0, and a 

process in one can be networked to a process in the other using DDE. 

If you intend to run both versions at one time, start the earlier version 

of Lookout first.

• Lookout 3.8 Citadel files cannot be used by Lookout 4.0. You should 

maintain old Citadel files separately from Lookout 4.0 database files. 

• Events are now stored with alarms and process data in the Citadel 

database. 

• The default location for data logged with the Spreadsheet object is the 

Lookout directory. The Lookout directory is also the default for any 

spreadsheet files you might export from the DataTable object or .csv 

(comma separated value) files you might create with the Print Alarms 

dialog box. If you do not want these files to be created in the Lookout 

directory, enter a complete path (including file name) for the location 

where you want the file created.
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Converting Lookout 3.8 Processes to Lookout 4.0
To load a Lookout 3.8 process file in Lookout 4.0, select File»Open and 

set the Files of type to Lookout Source Files (*.lks). 

  

Select the file you want to convert and click on the Open button 

(or double-click on the file name). Lookout uses the built-in CBL 

compiler to recompile the 3.8 source file into a Lookout 4.0 process file.

Converting 3.8 files may require tweaks and fixes, as indicated in the 

following list:

• Lookout 3.8 versions of the Pot, Switch, Pushbutton, and TextEntry 

objects that are remoted convert as L3Pot, L3Switch, and so on, and 

continue to function as they formerly did. You cannot create new 3.8 

objects like these through Lookout 4.0. 

Because remote position source connections have changed in response 

to the demands of networking, you may find you want to replace L3 

versions of these controls with the new Lookout 4.0 versions, 

especially if you want these controls to operate over a network. Delete 

the old controls and replace them with new controls using the same 

names. The Connection Browser and Object Explorer can help you 

track all the connections that may need to be re-established if you 

decide make these replacements.

• ODBC/SQL limitations. With the introduction of networking and 

hierarchical arrangement of objects within processes, it is easy to 

exceed the 62 character limit that exists in Microsoft Access and 

Microsoft Query. Even fully-compliant ODBC programs are limited to 

126 characters, so some consideration of these limitations when 

assigning computer, process, and object names is necessary, if you 

intend to use SQL queries. 

• The old LKSwap CBX no longer works. If you used this special object 

class from the old Lookout Evaluation Guide, you will have to replace 

it with the Lookout 4.0 Loader object, which is more flexible and 
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powerful than the old LKSwap object. Remember too that Lookout 4.0 

can run multiple processes, so it is not necessary to shut one process 

down before running another.

• Fonts are preserved when converting Lookout 3.8 process files from 

4.0 using the .lks file, but font code page information is lost. This 

appears to mostly affect international users whose languages use a 

different code page than the US code page. 

• The $Alarm object syntax in an .lks file has changed. The full URL 

for a $Alarm object will always be as follows: 

\\machine\process\$Alarm

• Your custom built Lookout 3.8 CBXs should run in Lookout 4.0, as 

long as they were developed using the Lookout Object Developer 

Toolkit. If you have problems with a custom CBX, contact National 

Instruments technical support for help in resolving the problem. 

• The Lookout HyperTrend object now accesses data through a URL 

connection. The data source for that connection must be logged to the 

Citadel database for the HyperTrend to display the data.

• When you convert a process with a Lookout 3.xx HyperTrend in it, 

Lookout automatically creates a named expression to make the URL 

connection to. Lookout automatically logs this named expression to 

the Citadel database. To maintain your converted HyperTrend objects, 

you must use or replace these named expressions.

• If you have Lookout 3.8 processes that use the NIDAQ or NISCXI 

objects, and you have a version 6.5.1 or earlier of NI-DAQ installed on 

your computer, you must upgrade to NI-DAQ 6.5.2 or better to use 

Lookout 4.0. You can download the current version of NI-DAQ 

software from the National Instruments web site, at 

www.natinst.com.

If your Lookout process will be running on the same computer as your 

National Instruments Data Acquisition or SCXI hardware, we 

recommend that you edit your process to use the OPCClient object to 

connect to NI-DAQ, for performance reasons.

Importing Old Security Files into Lookout 4.0
You can import the user account information from your Lookout 3.8 

processes into Lookout 4.0 using the Lookout User Manager.

1. Select Options»User Manager from the Lookout menu. You must be 

in edit mode for the User Manager item to appear in the Options menu. 

The User Manager dialog box appears.
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2. Select User»Import Security File from the User Manager dialog 

box. The following dialog box appears.

  

3. Navigate to your old Lookout 3.8 security file Lookout.sec, and 

select it. Lookout 3.8 kept the Lookout.sec security file in the 

Lookout directory.

4. Click on the Open button.

5. If you have already created any user accounts in Lookout 4.0 that are 

the same as accounts you used in Lookout 3.8, you will receive a 

message informing you that a user account with that name already 

exists. You may replace your recently created account, or choose not 

to use the old account information.

6. Exit the User Manager.



Note Unlike Lookout 3.8, Lookout 4.0 maintains the lookout.sec security file in the 

Windows System directory. 

The Lookout 4.0 User Manager creates a unique identification number for each 

user account. This means that to maintain identical accounts, you must use the same 

lookout.sec file for each copy of Lookout running on your network. Copy your 

lookout.sec file to the Windows System directory in every computer you intend to run 

Lookout on.

Redundancy
In Lookout 3.8 you used NetDDE to arrange for a standby computer to take 

over your process if the primary computer failed. 

All your NetDDE-based processes still work in Lookout 4.0, and your 

redundancy processes will also work.The method of switching control of 

your process from one computer to another has changed, however. You no 

longer set the name of a standby computer in the System Options dialog 

box. Instead, you install Lookout on your backup computer and create a 

monitor process with a Monitor and Loader object, just as you would for 

Lookout 4.0 processes as described in the Setting up the Standby Process 

and Computer section of Chapter 10, Redundancy, in the Lookout 

Developer’s Manual. 

You must also configure the process options so that your processes will 

save and use the most current state files in the event of a failure of the 

primary computer, as well as when the primary computer comes back on 

line. Configuring the state information for processes is also described in 

detail in the Setting up the Primary Process and Computer section of 

Chapter 10, Redundancy, in the Lookout Developer’s Manual. 

Your DDE-based client process works the same in Lookout 4.0 as it did in 

Lookout 3.8. You must therefore keep the naming conventions for primary 

and secondary computers using NetDDE redundancy that you used in 

Lookout 3.8. 

While we now recommend that you use the new TCP/IP networking with 

Lookout, the old documentation for DDE-based networking is contained in 

Appendix A, Networking With DDE, in the Lookout Developer’s Manual. 

Consult this appendix for maintaining old NetDDE processes. 

The process of making sure that your computers have a trusted share for 

DDE use, making sure NetDDE is running, and allowing file sharing is the 

same for Lookout 4.0 as it was for Lookout 3.8. 
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